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License

THE WORK (AS DEFINED BELOW) IS PROVIDED UNDER THE TERMS OF THIS CREATIVE COMMONS PUBLIC LICENSE ("CCPL" OR "LICENSE").
THE WORK IS PROTECTED BY COPYRIGHT AND/OR OTHER APPLICABLE LAW. ANY USE OF THE WORK OTHER THAN AS AUTHORIZED UNDER
THIS LICENSE OR COPYRIGHT LAW IS PROHIBITED.

BY EXERCISING ANY RIGHTS TO THE WORK PROVIDED HERE, YOU ACCEPT AND AGREE TO BE BOUND BY THE TERMS OF THIS LICENSE. TO
THE EXTENT THIS LICENSE MAY BE CONSIDERED TO BE A CONTRACT, THE LICENSOR GRANTS YOU THE RIGHTS CONTAINED HERE IN
CONSIDERATION OF YOUR ACCEPTANCE OF SUCH TERMS AND CONDITIONS.

1. Definitions

a. "Adaptation" means a work based upon the Work, or upon the Work and other pre-existing works, such as a translation, adaptation,
derivative work, arrangement of music or other alterations of a literary or artistic work, or phonogram or performance and includes cinematographic
adaptations or any other form in which the Work may be recast, transformed, or adapted including in any form recognizably derived from the
original, except that a work that constitutes a Collection will not be considered an Adaptation for the purpose of this License. For the avoidance
of doubt, where the Work is a musical work, performance or phonogram, the synchronization of the Work in timed-relation with a moving
image ("synching") will be considered an Adaptation for the purpose of this License.

b. "Collection" means a collection of literary or artistic works, such as encyclopedias and anthologies, or performances, phonograms or
broadcasts, or other works or subject matter other than works listed in Section 1(g) below, which, by reason of the selection and arrangement
of their contents, constitute intellectual creations, in which the Work is included in its entirety in unmodified form along with one or more other
contributions, each constituting separate and independent works in themselves, which together are assembled into a collective whole. A work
that constitutes a Collection will not be considered an Adaptation (as defined above) for the purposes of this License.

c. "Distribute" means to make available to the public the original and copies of the Work or Adaptation, as appropriate, through sale or other
transfer of ownership.

d. "License Elements" means the following high-level license attributes as selected by Licensor and indicated in the title of this License:
Attribution, Noncommercial, ShareAlike.

e. "Licensor" means the individual, individuals, entity or entities that offer(s) the Work under the terms of this License.

f. "Original Author" means, in the case of a literary or artistic work, the individual, individuals, entity or entities who created the Work or if
no individual or entity can be identified, the publisher; and in addition (i) in the case of a performance the actors, singers, musicians, dancers,
and other persons who act, sing, deliver, declaim, play in, interpret or otherwise perform literary or artistic works or expressions of folklore; (ii)
in the case of a phonogram the producer being the person or legal entity who first fixes the sounds of a performance or other sounds; and, (iii)
in the case of broadcasts, the organization that transmits the broadcast.

g. "Work" means the literary and/or artistic work offered under the terms of this License including without limitation any production in the
literary, scientific and artistic domain, whatever may be the mode or form of its expression including digital form, such as a book, pamphlet
and other writing; a lecture, address, sermon or other work of the same nature; a dramatic or dramatico-musical work; a choreographic work
or entertainment in dumb show; a musical composition with or without words; a cinematographic work to which are assimilated works expressed
by a process analogous to cinematography; a work of drawing, painting, architecture, sculpture, engraving or lithography; a photographic work
to which are assimilated works expressed by a process analogous to photography; a work of applied art; an illustration, map, plan, sketch or
three-dimensional work relative to geography, topography, architecture or science; a performance; a broadcast; a phonogram; a compilation
of data to the extent it is protected as a copyrightable work; or a work performed by a variety or circus performer to the extent it is not otherwise
considered a literary or artistic work.

h. "You" means an individual or entity exercising rights under this License who has not previously violated the terms of this License with respect
to the Work, or who has received express permission from the Licensor to exercise rights under this License despite a previous violation.

i. "Publicly Perform" means to perform public recitations of the Work and to communicate to the public those public recitations, by any
means or process, including by wire or wireless means or public digital performances; to make available to the public Works in such a way that
members of the public may access these Works from a place and at a place individually chosen by them; to perform the Work to the public by
any means or process and the communication to the public of the performances of the Work, including by public digital performance; to
broadcast and rebroadcast the Work by any means including signs, sounds or images.



j. "Reproduce" means to make copies of the Work by any means including without limitation by sound or visual recordings and the right of
fixation and reproducing fixations of the Work, including storage of a protected performance or phonogram in digital form or other electronic
medium.

2. Fair Dealing Rights. Nothing in this License is intended to reduce, limit, or restrict any uses free from copyright or rights arising from
limitations or exceptions that are provided for in connection with the copyright protection under copyright law or other applicable laws.

3. License Grant. Subject to the terms and conditions of this License, Licensor hereby grants You a worldwide, royalty-free, non-exclusive,
perpetual (for the duration of the applicable copyright) license to exercise the rights in the Work as stated below:

■ a. to Reproduce the Work, to incorporate the Work into one or more Collections, and to Reproduce
the Work as incorporated in the Collections;

■ b. to create and Reproduce Adaptations provided that any such Adaptation, including any translation
in any medium, takes reasonable steps to clearly label, demarcate or otherwise identify that changes
were made to the original Work. For example, a translation could be marked "The original work was
translated from English to Spanish," or a modification could indicate "The original work has been
modified.";

■ c. to Distribute and Publicly Perform the Work including as incorporated in Collections; and,

■ d. to Distribute and Publicly Perform Adaptations.

The above rights may be exercised in all media and formats whether now known or hereafter devised. The above rights include the right to
make such modifications as are technically necessary to exercise the rights in other media and formats. Subject to Section 8(f), all rights not
expressly granted by Licensor are hereby reserved, including but not limited to the rights described in Section 4(e).

4. Restrictions. The license granted in Section 3 above is expressly made subject to and limited by the following restrictions:

■ a. You may Distribute or Publicly Perform the Work only under the terms of this License. You must
include a copy of, or the Uniform Resource Identifier (URI) for, this License with every copy of the
Work You Distribute or Publicly Perform. You may not offer or impose any terms on the Work that
restrict the terms of this License or the ability of the recipient of the Work to exercise the rights granted
to that recipient under the terms of the License. You may not sublicense the Work. You must keep
intact all notices that refer to this License and to the disclaimer of warranties with every copy of the
Work You Distribute or Publicly Perform. When You Distribute or Publicly Perform the Work, You may
not impose any effective technological measures on the Work that restrict the ability of a recipient of
the Work from You to exercise the rights granted to that recipient under the terms of the License. This
Section 4(a) applies to the Work as incorporated in a Collection, but this does not require the Collection
apart from the Work itself to be made subject to the terms of this License. If You create a Collection,
upon notice from any Licensor You must, to the extent practicable, remove from the Collection any
credit as required by Section 4(d), as requested. If You create an Adaptation, upon notice from any
Licensor You must, to the extent practicable, remove from the Adaptation any credit as required by
Section 4(d), as requested.

■ b. You may Distribute or Publicly Perform an Adaptation only under: (i) the terms of this License; (ii)
a later version of this License with the same License Elements as this License; (iii) a Creative Commons
jurisdiction license (either this or a later license version) that contains the same License Elements as
this License (e.g., Attribution-NonCommercial-ShareAlike 3.0 US) ("Applicable License"). You must
include a copy of, or the URI, for Applicable License with every copy of each Adaptation You Distribute
or Publicly Perform. You may not offer or impose any terms on the Adaptation that restrict the terms
of the Applicable License or the ability of the recipient of the Adaptation to exercise the rights granted
to that recipient under the terms of the Applicable License. You must keep intact all notices that refer
to the Applicable License and to the disclaimer of warranties with every copy of the Work as included
in the Adaptation You Distribute or Publicly Perform. When You Distribute or Publicly Perform the
Adaptation, You may not impose any effective technological measures on the Adaptation that restrict
the ability of a recipient of the Adaptation from You to exercise the rights granted to that recipient
under the terms of the Applicable License. This Section 4(b) applies to the Adaptation as incorporated
in a Collection, but this does not require the Collection apart from the Adaptation itself to be made
subject to the terms of the Applicable License.



■ c. You may not exercise any of the rights granted to You in Section 3 above in any manner that is
primarily intended for or directed toward commercial advantage or private monetary compensation.
The exchange of the Work for other copyrighted works by means of digital file-sharing or otherwise
shall not be considered to be intended for or directed toward commercial advantage or private monetary
compensation, provided there is no payment of any monetary compensation in connection with the
exchange of copyrighted works.

■ d. If You Distribute, or Publicly Perform the Work or any Adaptations or Collections, You must, unless
a request has been made pursuant to Section 4(a), keep intact all copyright notices for the Work and
provide, reasonable to the medium or means You are utilizing: (i) the name of the Original Author (or
pseudonym, if applicable) if supplied, and/or if the Original Author and/or Licensor designate another
party or parties (e.g., a sponsor institute, publishing entity, journal) for attribution ("Attribution Parties")
in Licensor's copyright notice, terms of service or by other reasonable means, the name of such party
or parties; (ii) the title of the Work if supplied; (iii) to the extent reasonably practicable, the URI, if any,
that Licensor specifies to be associated with the Work, unless such URI does not refer to the copyright
notice or licensing information for the Work; and, (iv) consistent with Section 3(b), in the case of an
Adaptation, a credit identifying the use of the Work in the Adaptation (e.g., "French translation of the
Work by Original Author," or "Screenplay based on original Work by Original Author"). The credit
required by this Section 4(d) may be implemented in any reasonable manner; provided, however, that
in the case of a Adaptation or Collection, at a minimum such credit will appear, if a credit for all
contributing authors of the Adaptation or Collection appears, then as part of these credits and in a
manner at least as prominent as the credits for the other contributing authors. For the avoidance of
doubt, You may only use the credit required by this Section for the purpose of attribution in the manner
set out above and, by exercising Your rights under this License, You may not implicitly or explicitly
assert or imply any connection with, sponsorship or endorsement by the Original Author, Licensor
and/or Attribution Parties, as appropriate, of You or Your use of the Work, without the separate, express
prior written permission of the Original Author, Licensor and/or Attribution Parties.

■ e. For the avoidance of doubt:
■ i. Non-waivable Compulsory License Schemes. In those jurisdictions in which the right to collect

royalties through any statutory or compulsory licensing scheme cannot be waived, the Licensor
reserves the exclusive right to collect such royalties for any exercise by You of the rights granted
under this License;

■ ii. Waivable Compulsory License Schemes. In those jurisdictions in which the right to collect royalties
through any statutory or compulsory licensing scheme can be waived, the Licensor reserves the
exclusive right to collect such royalties for any exercise by You of the rights granted under this
License if Your exercise of such rights is for a purpose or use which is otherwise than noncommercial
as permitted under Section 4(c) and otherwise waives the right to collect royalties through any
statutory or compulsory licensing scheme; and,

■ iii. Voluntary License Schemes. The Licensor reserves the right to collect royalties, whether
individually or, in the event that the Licensor is a member of a collecting society that administers
voluntary licensing schemes, via that society, from any exercise by You of the rights granted under
this License that is for a purpose or use which is otherwise than noncommercial as permitted under
Section 4(c).

■ f. Except as otherwise agreed in writing by the Licensor or as may be otherwise permitted by applicable
law, if You Reproduce, Distribute or Publicly Perform the Work either by itself or as part of any
Adaptations or Collections, You must not distort, mutilate, modify or take other derogatory action in
relation to the Work which would be prejudicial to the Original Author's honor or reputation. Licensor
agrees that in those jurisdictions (e.g. Japan), in which any exercise of the right granted in Section 3(b)
of this License (the right to make Adaptations) would be deemed to be a distortion, mutilation,



modification or other derogatory action prejudicial to the Original Author's honor and reputation, the
Licensor will waive or not assert, as appropriate, this Section, to the fullest extent permitted by the
applicable national law, to enable You to reasonably exercise Your right under Section 3(b) of this
License (right to make Adaptations) but not otherwise.

5. Representations, Warranties and Disclaimer

UNLESS OTHERWISE MUTUALLY AGREED TO BY THE PARTIES IN WRITING AND TO THE FULLEST EXTENT PERMITTED BY APPLICABLE LAW,
LICENSOR OFFERS THE WORK AS-IS AND MAKES NO REPRESENTATIONS OR WARRANTIES OF ANY KIND CONCERNING THE WORK, EXPRESS,
IMPLIED, STATUTORY OR OTHERWISE, INCLUDING, WITHOUT LIMITATION, WARRANTIES OF TITLE, MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE, NONINFRINGEMENT, OR THE ABSENCE OF LATENT OR OTHER DEFECTS, ACCURACY, OR THE PRESENCE OF ABSENCE
OF ERRORS, WHETHER OR NOT DISCOVERABLE. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THIS
EXCLUSION MAY NOT APPLY TO YOU.

6. Limitation on Liability. EXCEPT TO THE EXTENT REQUIRED BY APPLICABLE LAW, IN NO EVENT WILL LICENSOR BE LIABLE TO YOU ON
ANY LEGAL THEORY FOR ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR EXEMPLARY DAMAGES ARISING OUT OF THIS LICENSE
OR THE USE OF THE WORK, EVEN IF LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

7. Termination

■ a. This License and the rights granted hereunder will terminate automatically upon any breach by You
of the terms of this License. Individuals or entities who have received Adaptations or Collections from
You under this License, however, will not have their licenses terminated provided such individuals or
entities remain in full compliance with those licenses. Sections 1, 2, 5, 6, 7, and 8 will survive any
termination of this License.

■ b. Subject to the above terms and conditions, the license granted here is perpetual (for the duration of
the applicable copyright in the Work). Notwithstanding the above, Licensor reserves the right to release
the Work under different license terms or to stop distributing the Work at any time; provided, however
that any such election will not serve to withdraw this License (or any other license that has been, or
is required to be, granted under the terms of this License), and this License will continue in full force
and effect unless terminated as stated above.

8. Miscellaneous

■ a. Each time You Distribute or Publicly Perform the Work or a Collection, the Licensor offers to the
recipient a license to the Work on the same terms and conditions as the license granted to You under
this License.

■ b. Each time You Distribute or Publicly Perform an Adaptation, Licensor offers to the recipient a license
to the original Work on the same terms and conditions as the license granted to You under this License.

■ c. If any provision of this License is invalid or unenforceable under applicable law, it shall not affect
the validity or enforceability of the remainder of the terms of this License, and without further action
by the parties to this agreement, such provision shall be reformed to the minimum extent necessary
to make such provision valid and enforceable.

■ d. No term or provision of this License shall be deemed waived and no breach consented to unless such
waiver or consent shall be in writing and signed by the party to be charged with such waiver or consent.

■ e. This License constitutes the entire agreement between the parties with respect to the Work licensed
here. There are no understandings, agreements or representations with respect to the Work not specified
here. Licensor shall not be bound by any additional provisions that may appear in any communication
from You. This License may not be modified without the mutual written agreement of the Licensor
and You.

■ f. The rights granted under, and the subject matter referenced, in this License were drafted utilizing
the terminology of the Berne Convention for the Protection of Literary and Artistic Works (as amended
on September 28, 1979), the Rome Convention of 1961, the WIPO Copyright Treaty of 1996, the WIPO
Performances and Phonograms Treaty of 1996 and the Universal Copyright Convention (as revised on
July 24, 1971). These rights and subject matter take effect in the relevant jurisdiction in which the



License terms are sought to be enforced according to the corresponding provisions of the implementation
of those treaty provisions in the applicable national law. If the standard suite of rights granted under
applicable copyright law includes additional rights not granted under this License, such additional
rights are deemed to be included in the License; this License is not intended to restrict the license of
any rights under applicable law.

Creative Commons Notice

Creative Commons is not a party to this License, and makes no warranty whatsoever in connection with the Work. Creative Commons will not
be liable to You or any party on any legal theory for any damages whatsoever, including without limitation any general, special, incidental or
consequential damages arising in connection to this license. Notwithstanding the foregoing two (2) sentences, if Creative Commons has expressly
identified itself as the Licensor hereunder, it shall have all rights and obligations of Licensor.

Except for the limited purpose of indicating to the public that the Work is licensed under the CCPL, Creative Commons does not authorize the
use by either party of the trademark "Creative Commons" or any related trademark or logo of Creative Commons without the prior written
consent of Creative Commons. Any permitted use will be in compliance with Creative Commons' then-current trademark usage guidelines, as
may be published on its website or otherwise made available upon request from time to time. For the avoidance of doubt, this trademark
restriction does not form part of this License.

Creative Commons may be contacted at http://creativecommons.org/.

Certain materials included in this publication are reprinted with the permission of the copyright holder.

Please see the Autodesk Creative Commons FAQ for more information.

Portions related to MD5 Copyright © 1991-2, RSA Data Security, Inc. Created 1991. All rights reserved. License to copy and use this software
is granted provided that it is identified as the “RSA Data Security, Inc. MD5 Message-Digest Algorithm” in all material mentioning or referencing
this software or this function. License is also granted to make and use derivative works provided that such works are identified as “derived from
the RSA Data Security, Inc. MD5 Message-Digest Algorithm” in all material mentioning or referencing the derived work. RSA Data Security, Inc.
makes no representations concerning either the merchantability of this software or the suitability of this software for any particular purpose. It
is provided “as is” without express or implied warranty of any kind. These notices must be retained in any copies of any part of this documentation
and/or software.
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Linux

Installation overview
Prerequisites:
■ A Linux PC that meets the requirements at the Creative Finishing Documentation web page.

■ The Autodesk Training Edition installation packages.

■ CentOS installation ISOs, a DVD writer and two blank DVDs.

Overview of the procedure:

1 Install and configure CentOS Linux (page 1).

2 Install the application (page 3)

3 Configure media storage (page 4)

4 Start the software according to the Startup options (page 4) and Configure the software (page 5).

Install and configure CentOS Linux
Prepare the installation media

When you install Linux, you need to include some extra packages, collectively called the kickstart (KS) file.
The custom Autodesk DVD of Red Hat Enterprise Linux for Autodesk hardware already contains the Autodesk
kickstart file. If you use a CentOS distro, you must add the kickstart file to the distribution. You do this by
running a script which takes the original CentOS ISO, adds the kickstart, and outputs the new ISO you use
to install Linux. For this you need:
■ A Linux PC with the contents of dist/kickstart/ from the Autodesk distribution. Instructions are in a

README file there.

■ The CentOS ISO files. It's a two DVD set.

■ A DVD burner and blank DVDs.

Procedure:

1 Run build_kickstart_cd. This adds the kickstart file to the ISO image of your Linux distribution DVD
or first CD. For example:

1

1

http://docs.autodesk.com/cf/index.html


build_kickstart_cd CentOS6_kickstart.cfg Centos6.5.iso Centos6.5_KS.iso

2 Burn the updated ISO image to a DVD. You can use the stock DVD2.

Install CentOS

1 Set the PC to boot from the optical (DVD) drive. Typically when a machine boots up there is a prompt
to enter the boot menu. On an HP workstation, press F9. On a DELL, press F12.

2 Boot the PC from your new kickstart DVD ISO.

3 At the CentOS "Welcome" screen, you are presenting a number of options you can select with the
arrow keys. Choose "Install system with a basic video driver": and hit the tab key. This presents the
command line with the vmlinuz command and some parameters that will be used to install the OS,
for example:

vmlinuz initrd=initrd.img

To this command you must append the kickstart parameters linux ks=cdrom so that the whole command
looks like:

vmlinuz initrd=initrd.img linux ks=cdrom

Hit Enter to begin the installation. You'll be prompted to set some system settings like language and
time.

4 Optional: if the installation hangs it may be because the installer doesn't have an appropriate driver
for your video card. Try appending text to the vmlinuz command, e.g.:

vmlinuz initrd=initrd.img linux ks=cdrom text

This runs the installer in non-graphical text-only mode.

5 When you are prompted for the installation type, choose "Create Custom layout". This lets you manually
initialize the hard disc. Delete the default partition scheme and partition your hard drive according to
the following example:

TypeMount pointSize (MB)Device

ext4/boot200sda1

swapFor 2GB RAM, 4GB; for 2-8GB RAM, equal to the
RAM; greater than 8GB RAM, at least 4 GB swap.

sda2

ext4/Set to "use remaining space".sda3

Basic configuration

After booting into your new Linux installation:

1 By default the PC system time zone is set to EST. If you want to change it, do so before installation the
Autodesk application.

2 Change the default root password. Log into your system as root, using the default password password,
and in a terminal run the passwd command.
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Disable OS updates

It is recommended to disable automatic OS updates. yumupdatesd, used in CentOS5 is not available in version
6.

1 Install and configure yum-cron: sudo yum install yum-cron.

2 The main configuration file is /etc/sysconfig/yum-cron. By default it will check for and install updates
daily. Set CHECK_ONLY=yes to check for downloads but not install them.

3 Set the MAILTO token to send notifications to yourself.

4 Save the config file and restart the service. It will be run according to settings in /etc/cron.daily,
/etc/anacrontab, and randomized $RANDOMWAIT in /etc/sysconfig/yum-cron.

Basic network configuration

The following is just an example and your settings will vary according to your network environment. Edit
the files below as root, the reboot with reboot.
■ /etc/hosts: add the static IP address and host name for your system. You can also use DHCP.

■ /etc/sysconfig/network: add your HOSTNAME and GATEWAY IP address.

■ /etc/sysconfig/network-scripts/ifcfg-eth0: remove the line with GATEWAY token, at the IPADDR line,
replace the IP with your IP. Check the NETMASK IP value matches that of your network.

Install device drivers

■ In a terminal run init 3 to shut down the graphical environment and run in text mode. Install the
NVIDIA graphics driver. You can find out what NVIDIA card you have with lspci | grep -i nvidia.

■ For WACOM drivers, see the Linux Wacom Project on sourceforge.net.

Install the application
A training version cannot be installed on the same system as the licensed version.

1 In a terminal, as root, cd to the directory where you downloaded the installer files and run the
pre-installation script: ./INSTALL_FIRST. This changes some system settings.

2 Start the application installation by running the installer script which should look like
./INSTALL_PRODUCT, for example ./INSTALL_FLAME.

3 If you are upgrading from a previous version, earlier versions are detected. You are prompted to select
one of those versions. Click None for a clean installation, or select one of the previous versions if you
want to copy its custom resource and setup directories to the new version.

4 If changes are detected in /etc/X11/xorg.conf, you are prompted to configure this file. If you modify
xorg.conf, you are prompted to restart the X server. When the installation script completes, log out
of the Linux desktop and then log in again to restart the X server.
■ To keep the old configuration settings, when the file appears in xxdiff, in the Global menu, choose

Select Left, and then, in the File menu, choose Save as Right. If prompted to overwrite, click OK.

■ To use the new configuration file without adding the settings from the old configuration file, just
close the program.

This installs the application, as well as WiretapCentral, Wiretap Gateway, Backburner Server, Backburner
Manager, Backburner Media I/O Adapter.
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Configure media storage
It is recommended to store media on a drive other than your system drive, ideally a direct attached storage
(DAS) device or a storage area network (SAN). You can store media on the system drive but performance will
not be as good, especially if it's in a partition on a mechanical hard disk.

Configure a standard filesystem as media storage:

1 Ensure the disk array or SAN storage is connected to your workstation and powered up, and that a
UNIX-compatible filesystem exists on the storage. For best performance, it is recommended to use a
filesystem known for high-performance media playback, such as XFS or SNFS.

2 In a terminal, as root. Stop Stone and Wire with /etc/init.d/stone+wire stop.

3 Create one or more Managed Media Cache directories:
■ If a mount point for your storage does not exist, create one, for example: mkdir -p /mnt/SAN1. Do

not use the reserved word “stonefs” as the name for your mount point directory. Mount the
filesystem to the newly-created directory. To mount it at boot, update /etc/fstab.

■ Create the Managed Media Cache directory on the mounted filesystem, in a directory named after
the workstation hostname. The Managed Media Cache directory should be named after the partition
name (by default, partition 7, or p7). For example, if the filesystem mount point is /mnt/SAN1, your
workstation hostname is adsk0, and the partition name is p7, type: mkdir -p /mnt/SAN1/adsk0/p7

■ Set the ownership for the directory to the root user. For example: chown -R root:users

/mnt/SAN1/adsk0/p7. Set permissions for the directory to be readable, writable, and searchable by
the owner and its group, and readable and searchable by all. For example: chmod -R 775

/mnt/SAN1/adsk0/p7

4 To make your application aware of the standard filesystem volumes, define the Managed Media Cache
of each volume as a partition in the Stone and Wire configuration file, and set its preferences in
/usr/discreet/sw/cfg/stone+wire.cfg. Update the keywords: Name, Path, Shared, and
SymlinkAcrossFilesystems.

5 If this is the first filesystem you are configuring for this workstation:
■ From /usr/discreet/sw/cfg/sw_framestore_map file get the FRAMESTORE value and use it to update

/usr/discreet/sw/cfg/sw_storage.cfg.

6 Restart Stone and Wire by typing: /etc/init.d/stone+wire restart.

7 Ensure the filesystem is mounted: /usr/discreet/sw/sw_df. Any project created in your application
after this point has the new standard filesystem partition as its primary partition. Any pre-existing
projects are unaffected by this setting and remain associated to their respective partitions.

Startup options
If you use the pen and tablet while the application is starting, the tablet will fail to initialise. Press
Shift+T+Insert to initialise the tablet if it does not function during a work session.

To start the application, double-click the application icon on the desktop. To start using a command line
option, open a terminal and type: <application_name> - <option>. For example
/usr/discreet/flame_2016/bin/flame_LINUX --help to see the startup options. Options are case-sensitive
and can be combined. Each option has a short form and a long form. The long form takes two hyphens.

The first time you start the software you'll have to click through a license agreement. Use the Project
Management menu to create a project and a user. You may be prompted to confirm the framestore
initialisation. Clicking yes does this and deletes all material on the framestore.

To start Lustre, log into the application’s Linux user account and double-click the Lustre icon on the desktop.
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Start-up options

b Execute batch. E.g. execute-batch-setup=FILE.

B Prevent the broadcast monitor from blanking when an image viewer or Player is not displayed. The
broadcast monitor then displays the screen content that is displayed in the corresponding region. This is
hardware dependent and may not work on all hardware configurations. Long form:
video-broadcast-always-on.

c FILE Use a configuration file other than the default, where FILE is the name of the file. If not specified,
the application looks first for init.cfg, and if that is not found, it looks for flame.cfg, then smoke.cfg. Long
form: config=FILE.

create-workspace Create workspace if specified or default workspace does not exist.

d Turn on debugging. Long form: debug

f FILE Use a custom menu file, FILE. For information on custom menus, see the application help. menu=FILE

F Force the application to install new fonts that were added to /usr/lib/DPS/outline/base (and /usr/lib/DPS/AFM,
if the corresponding font metric file was installed). init-install-font

help or ? To list all start-up options, use the h option.

H Specify the remote host name. Default is localhost. remote-host-name=STRING

J PROJECT Set the project that appears in the Project Management menu at startup. If used with J, the
application bypasses the Project Management menu. start-project=PROJECT.

local-start-user Start up with local user USER. Overrides U. --local-start-user=USER

L Disable writing to the .log file. The application keeps a log in the application home directory. The log file
is overwritten each time the application starts. log-off.

m Keep a copy when migrating projects from previous versions. --migrate-with-copy.

M Set the amount of memory assigned to frame buffering. This option overrides the default settings, or if
it has been uncommented, the value set by MemoryApplication in init.cfg. memory=MB

N Use Burn to execute batch setup. use-burn.

p <n> On multi-processor machines, start the application using less than the full array of processors, where
<n> is the number of processors to be used. Normally, the application uses all available processors. --cpu=n

red-frames Replace lost frames. Use with caution.

remote-start-user Start up with remote user USER. Overrides U.

usage Display a usage message.

U USER Start with user USER. If used with U, the application bypasses the Project Management menu.
Ignored if local-start-user or remote-start-user are set. --start-user=USER

W WORKSPACE start up with workspace WORKSPACE. Long form is start-workspace=WORKSPACE

Z Skip framestore sanity check. Long form is init-framestore-skipsanity

Command-line kill shortcuts

Configure the software
Application setup can be done via the graphical setup utility which can be accessed from an icon on the
desktop, or by editing configuration files.
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General

Video Device The video card used to connect to the VTR and broadcast monitor. Sets the video device
keyword in /usr/discreet/[product_name]/cfg/init.cfg.

Audio Device The device used for audio output. Sets the video device keyword in
/usr/discreet/[product_name]/cfg/init.cfg.

Reserved Application Memory The amount of memory allocated to frame buffers used by modules such
as the Player, Action, Input/Output clip. Sets the video MemoryApplication keyword in
/usr/discreet/[product_name]/cfg/init.cfg. Can be set manually, or set to Automatic. If set to Automatic,
the MemoryApplication keyword is commented out in init.cfg, and memory is allocated according to the
amount of system RAM:
■ 32GB or more: 33 per cent of RAM is allocated.

■ Less than 32GB: 50 per cent of RAM is allocated up to 4GB, or up to 3GB if less than 11.5GB RAM.

Network Panel Display The behaviour of the Network Panel. Show Mounted (default) displays only the
framestores known to be available. Show All displays all known framestores without checking their status.
Sets the NetworkPanelDisplay keyword in /usr/discreet/[product_name]/cfg/init.cfg.

Default Web Browser The browser used to browse the documentation and to view an archive's HTML tables
of contents. Set to open to use the default system browser. Sets the DefaultWebBrowser keyword in
/usr/discreet/[product_name]/cfg/init.cfg.

Archive  Sets the destination directory. Its default value is /usr/discreet/archive. It can be relative to the
home directory of the application by prefixing the path with a tilde (e.g. ~/archive). To save table of contents
in a directory relative to the project directory, refer to the ARCHIVELIBRARY keyword section of the project
config file. The ArchiveLibrary keyword of the project config file, if set, has precedence over this one. Sets
the ArchiveLibrary keyword in /usr/discreet/[product_name]/cfg/init.cfg.

Single Screen  This option is shown only if multiple screens are detected on the system. When enabled, the
UI of the application is restricted to a single screen.

Preview

Video Preview Device  keyword specifies the device used for the graphics-to-video display. Sets the
VideoPreviewDevice keyword in /usr/discreet/[product_name]/cfg/init.cfg.

Vtr

Vtr Identifies video tape recorders that can be used for clip I/O. Any enabled VTR can be selected for a project,
regardless of the project's video I/O timings. Sets the Vtr keyword in
/usr/discreet/[product_name]/cfg/init.cfg.

Media Storage

Media Storage Configures /usr/discreet/sw/cfg/stone+wire.cfg.

Backburner

Local Server Setting The network name of the workstation running the Backburner Manager. In a standalone
setup, use localhost (the default). In a render-farm setup, enter the name of the dedicated Backburner
Manager workstation.

Xorg.conf

Screen Selection Configures /etc/X11/xorg.conf.

6 | Chapter 1   Linux



Uninstall
1 If you are logged in as the application user in KDE, log out and log back into KDE as root.

2 From the KDE menu, choose Autodesk > Remove Software.

3 Select the packages you want to uninstall in the RPM list on the left (click Select All to select all the
packages), then click the arrow to move them to the RPM uninstall list on the right then click Next.

4 In the Choose folders window choose the application directories you want to remove from the
/usr/discreet directory, and click Next.

5 In the confirmation dialog click Uninstall & Remove. The uninstallation starts and displays details on
the process.

6 Optionally delete the log files associated with a given application version in /usr/discreet/log, or
/var/log/ for Flame.
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Mac OS X

Install
If you are installing Flare or Flame Assist on a fresh new install of Mac OS X, first verify that the hostname
and Computer Name are the same:

1 In a terminal, get the hostname of the workstation with the hostname command.

2 In Systems Preferences > Sharing, check that Computer Name is the same as the hostname.

3 If the names are different, change the Computer Name to that of the hostname, and then proceed
with the install. If they're the same there's nothing more to do.

If you've already installed the application without first verifying that the Computer Name and the hostname
match, and if the application complains that Stone+Wire cannot start, try the following:

1 In a terminal, as root, create /usr/discreet/clip/.

2 In a terminal, get the hostname of the workstation with the hostname command.

3 In Systems Preferences > Sharing, check that Computer Name is the same as the hostname. Change
the Computer Name to the hostname if they are different.

4 Using the Setup Assistant, under Media Storage, you should now be able to try and add a new partition.
The Setup Assistant in available in Applications/Autodesk/[Flame Assist or Flare]/Utilities.

5 Start Stone+Wire using the Service Monitor application, also found in the Utilities folder.

To install you'll need the DMG files containing the installer; they are linked from the release notes. You'll
also need an administrator password for your Mac.

1 Open the DMG image file, and double click Install <product>, then click through the installer.

2 If your system has multiple drives, you may be prompted to choose a drive. For the media storage
device it is recommended, but not required, to use a drive other than your system drive. Wherever you
place the media cache, you can stop Spotlight indexing it from System Preferences > Spotlight > Privacy.

3 Once you exit the installer, the application is ready to use. A link to the app is in Applications/Autodesk.

The following is also installed. To see if the service is properly running, after installation go to:
Applications/Autodesk/<product>/Utilities/Service monitor.
■ Autodesk Wiretap Gateway: a background service used for media import.

■ Autodesk Backburner Manager & Server: background renderer.
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■ Stone+Wire: tools installed with all Creative Finishing applications, except Lustre.

Uninstall

1 Run Applications/Autodesk/<product>/Utilities/Uninstall. This leaves directories containing
configuration files, project data and user preferences. This helps when reinstalling. All versions of the
application use /usr/discreet and it must be kept if you have other versions installed.

2 To optionally remove all files:

1 In a Terminal , run sudo rm -rf /usr/discreet /Applications/Autodesk/Smoke*

/Applications/Autodesk/Flare* /Applications/Autodesk/Flame\ Assist* according to which
applications you want to delete. This cannot be undone.

2 The installer shares /usr/discreet over the network.To disable that, comment out the line
/usr/discreet -network -maproot=root in /etc/exports, then restart the computer.

Configure the application
OS X system preferences

These must be set for each user account:
■ The OS X firewall must be off (default setting), otherwise it blocks incoming network connections.

■ By default the application uses keyboard shortcuts that conflict with the OS X default settings. In Keyboard
> Keyboard Shortcuts, disable shortcuts using the function keys (F1, F2), control key, or option meta key.
If the Mac has an Apple keyboard enable Use F1, F2, etc. keys as standard function keys at Keyboard >
Keyboard tab.

■ Sharing: turn Web Sharing on to enable Wiretap Central and Backburner Web Monitor.

■ Spotlight: in the Privacy tab, add the media storage volume to the list of locations Spotlight does not
search.

■ Sound: if you are using an AJA I/O device, ensure it is not selected for sound output.

Configure the application with the Setup Utility

Run the Setup utility from /Applications/Autodesk/<product>/Utilities/.

If you have multiple versions installed, select the version you want to configure from the drop-down list at
the top of the window.

In the Preview and Vtr tabs, the Duplicate and Delete buttons apply to the selected entry, not the one checked
under Active.

To discard unsaved changes in all the tabs of the setup utility, click Reload.

To edit the parameters directly in the application configuration file, click Manual Edit. It can be backed up
at /usr/discreet/<product>/cfg/init.cfg.

General

Video Device The video output device to be used.

Audio Device The audio output device to be used. If your Mac is equipped with an AJA device, select AJA.
If it is equipped with a Blackmagic Design device, select BMD. Otherwise, select CoreAudio to use the default
sound card of your workstation. You can only use the audio device that matches the video device. Similarly,
you can only use CoreAudio if neither AJA nor BMD is set as the video device.
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Reserved Application Memory The amount of memory allocated to frame buffers used by modules such
as the Player, Action, Input/Output clip. Sets the video MemoryApplication keyword in
/usr/discreet/[product_name]/cfg/init.cfg. You can set this manually, or set it to Automatic. If set to
Automatic, the MemoryApplication keyword is commented out in init.cfg, and memory is allocated
according to the amount of system RAM:
■ 32GB or more: 33 per cent of RAM is allocated.

■ Less than 32GB: 50 per cent of RAM is allocated up to 4GB, or up to 3GB if less than 11.5GB RAM.

Network Panel Display

ShowAll displays all known framestores in the Network panel without verifying their availability.
ShowMounted displays only available framestores.

Default Web Browser  The Web browser used by the application. To use your Mac's default browser, set to
open.

Default Shortcut Profile  Sets the keyboard shortcut configuration to be used.

Menu Bar Sets whether the menu bar is displayed in the application.

Table of Contents Location The path where online HTML and ASCII tables of contents are saved when
archiving. The default location is /usr/discreet/archive.

Single Screen  This option is shown only if multiple screens are detected on the system. When enabled, the
UI of the application is restricted to a single screen.

Preview

Specifies the device used for the broadcast monitor connected through an AJA or Blackmagic Design device.
Enable entries for the resolutions of your projects, as well as the resolutions supported by your hardware
configuration.

If you go from a Blackmagic Design to an AJA device after installation , or from an AJA to a BLackmagic
Design one, you must update. The following 1920x1080 timings are only supported when using an AJA
Kona 3G: 50p, 5994p, and 60p.

If you do not have a sync connected to your workstation, enable some free run timings for your broadcast
monitoring. Enable the timings with a SyncSource set to freesync.

Vtr

If you have an AJA or Blackmagic Design device connected to a VTR, enable the timings you plan on using
with the connected VTR. AJA devices support 3G-SDI connections. Blackmagic Design devices do not.

Media Storage

This is the path to where all imported and rendered frames are stored. It is recommended to use a fast drive,
and not to use your system drive. To define a new media storage volume, click Add. Click Manual Edit to
edit the configuration file in a text editor. You also need to use manual edit to delete a storage volume.
Parameters:
■ Name: a label to identify the media storage. Required.

■ Location: path to the media files on your storage device. Do not select the root of a drive as your media
storage folder. Create a subfolder to hold all your media files in one place. The recommended folder
name is Autodesk Media Storage/. Required.

■ 8-bit Integer, 10-bit Integer, 12-bit Integer and 12-bit Packed Integer. The file formats used when writing
frames of those bit depths to the storage. Optional.

Configure the application  | 11



■ Jpeg Compression: can be set from 0 (lowest compression, highest quality) to 100 (highest compression,
lowest quality). Optional.

Backburner: configure background processing

Manager Hostname The hostname or IP address of the Backburner Manager system that will handle
background jobs. This enables the Background Wire and Background Proxies buttons in the application;
they are otherwise greyed out.

Configure Wacom pen buttons

1 Open the System Preferences / Wacom Tablet panel.

2 If Grip Pen does not appear in the Tool section, touch the pen on the tablet.

3 Select the Pen tab.

4 Ensure the top pen button is assigned to the double-click function, and that the bottom pen button
is assigned to the right-click function.

Advanced network configuration

If your system is not using the correct network interface, for example wifi vs. ethernet, you can specify which
local interfaces it should use in /usr/discreet/cfg/network.cfg. Documentation about the syntax is in the file
itself. You can hard code a default device and a fallback device for data transfer and for multicasting.

Troubleshooting & support
Media storage problems

■ You may need to reconfigure your media storage if it is trying to use hardware that is no longer available.

■ Repairing media storage mount points: if your Mac experiences a hard reboot (e.g. because of a power
outage), when it restarts the operating system may mount the media storage incorrectly (for example,
/Volumes/Storage1 instead of /Volumes/Storage). If media storage will be inaccessible. To delete an
incorrect mount point:

1 On your Mac, go to System Preferences / Sharing, and disable all the file services.

2 In Finder use command+shift+g to navigate to /Volumes.

3 In Volumes/, find the incorrect mount point folder. It should have the name of the original mount
point (for example, Storage), but its icon depicts a folder instead of a disk drive.

4 Delete the folder.

5 Restart the Mac. Restore System Preferences / Sharing settings.

6 If the media storage is still not available after restart, use the Mac application Disk Utility to repair
the media storage disk. See the Mac documentation for details.

Fix VOLUMEMGT and No Volume errors

Follow the steps below if you cannot select your framestore volume, or if you get the following error: Error:
VOLUMEMGT : Failed to initialize Stone+Wire connection.

1 Exit the application.

2 Open Applications / Autodesk / <product>/Utilities / Service Monitor.

3 Restart the Stone+Wire service and start the application.
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Backburner

To restart Backburner Manager:

1 In a terminal, check that the Backburner Manager service is running: sudo ps -ef | grep -i backburner

2 If backburnerManager does not appear in the output of the command, restart the Backburner Manager
service: sudo /usr/discreet/backburner/backburner_manager restart

3 To view details on the Manager's status, run the Console application from Applications / Utilities,
and look for entries containing com.autodesk.backburner_manager, or check the backburner log files
in the /usr/discreet/backburner/Network directory.
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License the software

Subscription customers can choose between permanent node-locked or network licenses. Otherwise only node-locked is
available.

Node-locked

Node-locked licenses are locked to one computer. You receive a temporary node-locked license when you purchase your
software or when you get a subscription update. A four day temporary license is available via the emergency license
generator at http://melicensing.autodesk.com/templicensing/.

1 When an unlicensed application is started, the License Wizard starts. Click through it to request a license code. Log
in to support portal: https://edge.autodesk.com/LicenseAssignment and follow the links.

2 Relaunch the License Wizard and use it to insall the Node-Locked License. Copy and paste the license from the email.

Network licensing

A single license server can be run on a Creative Finishing Linux workstation, or on a remote Linux machine. The license
server can run on any machine with the same specification as a current certified Creative Finishing Linux workstation.

Redundant licensing can be set up with one server as the master and two backup servers on the same subnet. All servers
must use the latest version of FLEXlm. In /usr/local/flexlm/licenses/DL_licenseNetwork.dat there would be three
SERVER keywords. For redundant license servers, reboot each server in close sequence to properly restart the license system.
By default, redundant license servers are set to port 27005.

1 The network server is installed with the script INSTALL_LICSERV which is found at the root of the Creative Finishing
installation package.

2 The license key is machine-dependent. Get the host ID of the license server: in a terminal run
/usr/local/bin/dlhostid.

3 Request license codes at https://edge.autodesk.com/LicenseAssignment. Follow the links to set up the license server assets
and select the software to be accessed with a network license. Your license codes are emailed to you.

4 Create the license server file on a license server: as root, edit (create if necessary)
/usr/discreet/licserv/licenses/DL_license.dat, following the example in the email from Autodesk.

5 Start or restart the license server with /etc/init.d/license_server start or /etc/init.d/license_server restart.
Stop it with /etc/init.d/license_server stop. Check the boot.log file for the server status.

6 Create license files for the application on its workstation. Edit (create if necessary) as root
/usr/local/flexlm/licenses/DL_licenseNetwork.dat. Add the SERVER, VENDOR and USE_SERVER strings provided
by Autodesk. The License Wizard can also be used, which launches when an unlicensed application is started.
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To avoid conflicts with other applications or license servers on site, change the port setting used by a license server:

1 Log in as root to the license server and open /usr/discreet/licserv/licenses/DL_license.dat for editing.

2 Find the SERVER keyword, which by default has no port number specified. Enter another port at the end of the line
in the range of 27000-27009.

3 Restart the server: /etc/init.d/license_server restart.

4 Repeat for each workstation, using the same port as the one used for the license server.

License borrowing

It is possible to borrow a Flare or Flame Assist license from the license server, disconnect from the network and use the
license with no connection to the server. For Linux it is available for single GPU only. The license server must be running
the latest server software available with 2016 release.

To borrow a license for the current machine and user:

1 From the Help menu, choose Borrow License.

2 In the Borrow a License dialog, set the number of days after which the license will be automatically returned, and
click Borrow. A license can be checked out for 14 days or until the expiration date of the server license, whichever
comes first.

One day will have expired at midnight on the day the license is borrowed. A borrowed license can be returned before the
end of the borrowing period:

1 If you have not done so since borrowing the license, quit and restart the application.

2 From the Help menu, choose Return License, and click Confirm. This option is only available if your workstation is
using a borrowed license.

ADLM license files

Whether running a local or remote ADLM license server, there are two files associated with your license:
■ /var/flexlm/autodesk.lic: a file on the workstation that points to the license server. The license server can either be

running locally, or on another network machine.

■ /usr/local/flexnetserver/adsk_server.lic or /opt/flexnetserver/licenses/license.dat: the license server’s
license file, containing all of the licenses to be served by it.

The status of the licenses in the license file can be verified with the command: /usr/local/flexnetserver/lmutil lmstat

-a -c adsk_server.lic

Restart ADLM license servers

If any changes are made to the license file, the server must be restarted.
■ To restart a local OS X server: in the /Applications/Autodesk/Smoke Common Utilities/Service Monitor utility,

License Server (ADLM) section, click Restart.

■ To restart a networked OS X server: on that server run /usr/local/flexnetserver/lmutil lmdown -q -force. Then
restart it with : /usr/local/flexnetserver/lmgrdLauncher.

■ To restart a networked Linux license server, run: /opt/flexnetserver/lmgrd-c adsk_server.lic -l adskflex.log.
This creates a log file /opt/flexnetserver/adskflex.log.
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Fix local hostname changes

The license server hostname is listed in the license files /usr/local/flexnetserver/ads_server.lic and
/var/flexlm/autodesk.lic. If that hostname changes, the license files must be changed to match. The second item on
the SERVER line must match the current workstation hostname:

SERVER <current_hostname> 00101804d4e8 27100

Do not use localhost as a hostname.

Then restart the local license server with /Applications/Autodesk/Smoke Common Utilities/Service Monitor.

To prevent problems with hostname changes on a local license server, replace the hostname with 127.0.0.1 which makes
the license insensitive to hostname changes.
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